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1 What’s New for Oracle WebCenter Forms Recognition 
12c (12.2.1.3.0)

This section introduces the new features and enhancements of Oracle WebCenter Forms 

Recognition:

Category Description

Installation  The Address Analysis engine has been removed from the product.
 All Executables are now digitally signed.
 The Project Migration Tool has been removed from the product.
 The Recognita Barcode engine has been removed from the product. Existing projects 

using Recognita are updated to use the QualitySoft engine instead.
 The Recognita OCR engine has been removed from the product.

Platform  WebCenter Forms Recognition now supports Amazon EC2.
 WebCenter Forms Recognition now integrates Document Filters 11.4.0.2480, which 

provides several updates and enhancements.
 WebCenter Forms Recognition now supports Windows 10.
 WebCenter Forms Recognition now supports Oracle 12c Database.
 WebCenter Forms Recognition now supports .NET Framework 4.5.2.

Runtime Server  A new Minimize project reloading option has been introduced to optimize project 
reloading. Refer to the WebCenter Forms Recognition Runtime Server Guide for more 
information.

 The process of preloading documents during Import has been improved. The time 
required for Import no longer depends on the number of pages.

 Furthermore, the performance when importing electronic documents as well as in 
subsequent processing has been improved.

 For new installations, the Runtime Server now uses the Windows Processor Affinity by 
default. To change this behavior, modify the EnableProcessorBalancing registry setting.

 The handling of non-image-based PDF documents has been improved.

Scripting  The new method SetFieldFocus is available in SCBCdrVerificationForm. Use this method to 
set the focus to the specified field or table column and to update the HighlightField, 
HighlightColumn, and HiglightRow settings. Refer to the SetFieldFocus in WebCenter 
Forms Recognition Scripting Guide.

 The new named property SkipDocumentReprocessingAfterMerging has been introduced to 
improve the performance when merging large documents. Refer to the 
SkipDocumentReprocessingAfterMerging in WebCenter Forms Recognition Scripting Guide.

 The new property DocumentBinarizationMode and the new type definition 
CdrDocumentBinarizationMode has been introduced to enable specifying the binarization 
mode. Setting the DocumentBinarizationMode to CdrDocumentBinarizationSkipped may 
improve OCR results for grayscale and colored images. Refer to the 
CdrDocumentBinarizationMode and DocumentBinarizationMode in WebCenter Forms 
Recognition Scripting Guide.

 Added the method ExportToXML along with the data type CdrExportType to the 
SCBCdrWorkdoc class to enable the export of Workdoc word and characters data to an XML 
file with a specific format.

 Added the property SrchFlag to the SCBCdrFormatSettings class to enable the options Keep 
spaces between connected words and Compare case sensitive for individual Format 
String expressions.

 Added the method TestString to the SCBCdrFormatEngine class to enable calculation of the 
distance of an arbitrary text against a Format String expression.

Documentation The Workdoc Browser tool is documented in the WebCenter Forms Recognition Online Help.

Designer  The processing time of the Format analysis engine can now be reduced by applying a 
template or identical settings to multiple fields.
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Category Description

 When OCR is performed on a PDF file, which has been imported as a CI document, any 
page for which no electronic text is detected is OCR’ed as an image, using zone All OCR 
settings of the project.

 In the Designer Verifier Test and Train modes, you can now enable a setting to trigger the 
VerifierFormLoad event. Earlier, this event was only triggered in the Verifier application. 
For backwards compatibility, this setting is disabled by default.

 The Advanced Line Extraction engine is now compatible with the Brainware Table 
Extraction Engine.

Engines  The extraction of the Generic Table Extraction engine has been improved for large multi-
page tables.

 Added support for a server edition of the Kadmos 5 Engine capable of processing 
documents in multiple threads.

Check Analysis Engine  A new Check Analysis Engine dedicated to extracting information from business and 
personal checks, including hand-printed checks, is available in the product.

 The Check Analysis Engine is capable of extracting key information from business and 
personal checks, such as the MICR Line, Courtesy Amount, Legal Amount, Check Date, 
Check Number, Remittance Location, Signature detection, and the Payee.

 A Payee Dictionary can be added to improve the extraction of handwritten payee names. 
Likely payee names can be added as values in the user interface, or dynamically using 
custom scripting.

 Scripting methods and properties are provided to support the engine.
 The Check Analysis Engine does not require OCR processing to be performed on 

documents.

Logging Component trace logging has been activated for StrComp. A log file named 
I_[YYYYMMDD]_CdrStrComp_[nnnn].log may appear in the log directory.

Runtime Server and 
Verifier

Database queries performed during project and batch loading have been optimized.

Web Verifier  The Web Verifier client now supports Google Chrome.
 The Web Verifier client provides enhanced network security to address common web 

security Sensitivities.
 The red highlight box now displays as a margin around the text to prevent obscuring the 

highlighted text.
 The margin of the red highlight box is now larger. This helps prevent situations where the 

box might hide other text in the document.
 In Table Correction, selection of multiple items in a table column now has a margin 

identical to the margin around text fields.
 The text to margin ratio remains unchanged for all zoom levels.
 The Remember me next time check box was removed from the login page.
 The Web Verifier application offers improved security by using SECURE or HTTPONLY

attributes for all web cookies.
 The Cache-Control no store and Pragma no cache metatags were added to the login page to 

decrease sensitivity to certain common web security attacks.
 The performance of the Web Verifier application is improved by usage of PNG images 

instead of JPEG images, which significantly reduces image size, resulting in faster image 
transfers.

 The performance of the Web Verifier application is improved by removing an erroneous 
functionality where the document was saved twice when validating the last invalid field.

 Removed click-jacking vulnerabilities from the Web Verifier application.
 Improved the error-handling feature of the Web Verifier application by displaying user-

friendly error messages for both authenticated and unauthenticated users. Previously, 
Web Verifier displayed error stack traces or developer-oriented information.

 The Web Verifier application now identifies and synchronizes only the modified images 
while saving the workdoc, thus enhancing the loading of documents in Web Verifier. 
Previously, images associated with a workdoc were synchronized with the database while 
saving the workdoc, whether the image was modified or not.



Oracle WebCenter Forms Recognition 6 Oracle WebCenter Forms Recognition Release Notes

Category Description

 The key name that configures the Help menu in web.config has been changed from 
VerifierHelpSource to HelpLink. The VerifierHelpSource key is no longer in use.

 Removed a potential Web Verifier sensitivity to cross-site request forgery attacks.

Note: There has been no change in AP Project 1007G. This version (1007G) of the AP Packaged 

Project is compatible with Oracle WebCenter Forms Recognition version 12.2.1.3.0. Refer 
to the WebCenter Forms Recognition Migration Guide for more information.
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2 Issues fixed in Oracle WebCenter Forms Recognition 12c 
(12.2.1.3.0)

The following issues were fixed:

Category Description

Installation  Resolved an issue where specific documents were rendered incorrectly due to missing 
fonts. The WebCenter Forms Recognition installation now includes the Document Filters 
Fonts directory.

 Resolved an issue where the machine.config file did not update with the Oracle DB 
provider when upgrading from an older version of the product that was using .NET 
version 3.5 SP1 and was configured to use the Oracle database. As a result, Oracle 
WebCenter Forms Recognition applications could not work properly with the Oracle 
database.

 Resolved an issue where an installation on a system with Chinese (Simplified, PRC) locale 
resulted in a corrupted web.config file, because ANSI encoding was used instead of UTF-
8 encoding.

 Resolved an issue where in some installations the Workdoc Browser could not locate the 
stdole.dll, which is required to access the database. This caused the Workdoc Browser to 
stop working. A copy of the stdole.dll is now included in the directory that contains the 
Workdoc Browser application.

Runtime Server  Resolved an issue that occurred when Runtime Server stopped responding after a user 
deleted a group that contained a machine named localhost.

 Resolved an issue where only 64 RTS instances running concurrently with high priority 
processed batches, even if more instances were running and more batches were available. 
This issue occurred with MS SQL Server and Oracle databases.

 Resolved an issue where Runtime Server was incorrectly counting number of imported, 
OCR'ed and classified documents.

 Resolved an issue where some of the text labels or messages displayed in a mixture of 
English and German when the user viewed the Runtime Server MMC settings on a 
German workstation.

 Resolved an issue where one instance stopped working during OCR of the first document 
when three or more OCR instances with two or more instances using FineReader 11 were 
launched. This issue only occurred when using file system batches.

 Resolved an issue where only 32 CPU cores were used when more than 32 Runtime 
Server instances using FineReader11 ran simultaneously on a system.

 Resolved an issue where a batch was occasionally processed more than once when 
multiple Custom Processing instances ran simultaneously.

 Resolved an issue where the OCR or the subsequent processing could fail if a single line 
contained an unrealistic large number of words. The words are now wrapped to a second 
line, which enables the OCR to complete and the subsequent processing to continue.

 Resolved an issue that caused a race condition in the handling of CI documents, where 
applications could terminate or fail to function correctly.

 Resolved an issue where Runtime Server instances sporadically stopped working due to 
high memory utilization.

 Resolved an issue where both the instance and the batch being processed could be 
prevented from further processing if the Process ID (PID) of a crashed Runtime Server 
instance was recycled by a Windows system process. Such PID recycling is now detected 
and locks are removed to allow processing to continue.

Verifier  Resolved an issue where no new line was added to a table cell when the user placed the 
cursor in the input area and pressed [Ctrl] + [Enter] key.

 Resolved an issue where the first two list values were not present for the first document 
opened after launching Verifier when populating drop-down list values dynamically by 
script within the VerifierFormLoad event.

 Resolved an issue where the error message dialog did not display for invalid filter 
queries. Now, a message displays when an entered filter query is invalid.

 Resolved an issue where initial manual extraction to a table cell failed if one or more 
header fields were invalid.
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Category Description

 Resolved an issue where, when the user modified multiple fields and then pressed [Enter] 
key, the fields had to be validated one by one instead of validating them all together.
This issue occurred only when the user navigated between the fields by pressing [Tab] 
key.

 Resolved an issue where the VerifierFormLoad event was called before the BatchOpen
event.

 Resolved an issue that occurred in tables, where the user was prevented from merging the 
last row of a page with the first row of the subsequent page.

 Resolved an issue where merging rows that contain only manually typed data with rows 
that contain mapped data could result in loss of manually typed data.

 Resolved an issue that occurred in Document view, where cell data was invisible or 
incorrectly drawn for newly merged rows containing manually extracted data.

 Resolved an issue where row data may be lost when merging rows that contain mapped 
data together with rows that contain empty cells.

 Resolved an issue that occurred in Snippet view, where incorrect highlighting of newly 
merged rows was combined with rows that contain empty cells.

 Resolved an issue where a wrong vendor pool was used during extraction after manual 
reclassification.

 Resolved an issue where the cursor pointed to the wrong position after tabbing to next 
field. Now, the cursor goes to the first character with low OCR confidence or, if there are 
no characters with low OCR confidence, to the first character of the text in the field.

 Resolved an issue in Verifier where the cursor was not positioned next to the invalid 
character when a field with invalid characters was selected.

 Resolved an issue in Supervised Learning where the user was not notified about failures 
to apply learning with the local project.

 Resolved an issue that prevented batches with documents in an exception state from 
opening, in the same Verifier session, after the state changed.

 Resolved an issue where Verifier stopped working if the cut command [Ctrl] + [X] key 
combination was applied to an empty table cell.

 Resolved an issue where the Verifier application incorrectly selected the whole table cell 
or field content when the user set the Fields edit mode option to Overwrite and either 
clicked in the text or deleted a character by pressing [Backspace] or [Del] key.

 Resolved an issue that occurred when the user set up Batch Level Security with an SQL 
database, where the same batches repeated on several pages due to a broken pagination of 
the Batch List view.

 Resolved an issue where the cursor jumped to the start of the text field when the user 
entered text using the text auto-completion feature.

Web Verifier  Resolved an issue where Web Verifier failed to open a batch containing a document 
processed from a TIFF image with resolution unit value as one, and the error message 
Current workdoc was corrupted. Please reimport this document to the database appeared.

 Resolved an issue where Web Verifier failed to open a batch containing a document 
processed using a TIFF image with apostrophe (') in the name.

 Resolved an issue that occurred when users assigned to a batch could open and 
successfully process the same batch concurrently if Web Verifier was installed on a multi-
server environment.

 Resolved an issue in which the Web Verifier application froze when the user selected a 
vendor item detail, pressed the [Esc] key, and then immediately navigated to the next 
document and clicked Close on the Save Current Document dialog box. The issue also 
occurred when the navigation pane froze for the following scenarios. 

o When the user changed a document and then navigated to the next document 
and clicked Close or pressed the [Esc] key on the Save Current Document 
dialog box. 

o When the user selected a vendor item detail, pressed the [Esc] key, and then 
immediately navigated to the next document and pressed the [Esc] key on the 
Save Current Document dialog box.

 Resolved an issue in which a duplicate database entry was created in the Settings table 
every time a new user with no pre-configured settings clicked Save after modifying any 
setting on the Settings page.

 Resolved an issue in which the time taken to verify fields was more than expected when 
the user attempted to validate fields after changing projects within the same session. This 
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Category Description

issue occurred when the user opened an Associative Search Engine script dialog box in 
the first project while verifying a batch.

 Resolved an issue in which the indexing view was erroneously refreshed when the user 
pressed the [Backspace] key either with the mouseClicked form event enabled or for read-
only fields.

 Resolved an issue in Indexing view, which enabled the user to erroneously inject HTML 
content in a table cell.

 Resolved an issue in Indexing view where the [Backspace] key erroneously functioned as 
the browser Back button when the user attempted to modify a read-only field using the 
[Backspace] key in Internet Explorer.

 Resolved an issue in Classification view in which the Web Verifier application 
erroneously navigated to the next invalid document when the user pressed [Enter] in the 
class name box without selecting a class.

 Resolved an issue in which the error message ActiveX Automation: Object var is 'Nothing'
appeared while accessing properties or methods of the Workdoc parameter inside the 
WinWrap script event for the CellFocusChanged event.

 Resolved an issue in which the error message Document loading failed was recorded in the 
trace log file when the user attempted to cut or append documents for a batch multiple 
times. However, the user was able to perform the cut or append operation successfully 
even when the error was recorded.

 Resolved an issue where the input state boxes on the Workflow Settings tab did not have 
any space between the controls.

 Resolved an issue in which the user was able to proceed further even on entering a value 
for the output state that was lesser than the value entered for the input state.

 Resolved an issue in Web Verifier where the ErrorDescription property was not emptied 
for the fields with the activated AlwaysValid flag, resulting in a status bar warning 
message when the user extracted the OCR’ed value for such fields and attempted to 
validate the fields.

 Resolved an issue where Web Verifier displayed double backslash in case a single 
backslash was present in content of the field candidate.

 Resolved an issue where a new exception batch was created with incorrect priority when 
the user moved a document to exception. This issue was noted only when there was 
already an exception batch in the job with lower priority number and a batch name 
identical to the newly created exception batch.

 Resolved an issue where the Select a knowledge base job error message did not display when 
the user selected the Activate supervised learning workflow option on the Supervised 
Learning tab and attempted to save the settings without selecting any job from the 
Knowledge base job list.

 Resolved an issue where changes were retained when the user changed the zoom level of 
a document and navigated to the next document when Keep Zoom option was disabled 
in the Extraction Verification view.

 Resolved an issue in Extraction mode where the focus remained on the selected field but 
the pointer was not visible when the user navigated to a different page.

 Resolved an issue where the Toolbar option was selected by default and the toolbar 
erroneously displayed in the Settings page when the user cleared the Toolbar option on 
the View menu and navigated between the Group settings view and My Settings view.

 Resolved an issue where the Company Logo option was selected by default but the logo 
did not display when the user cleared the Company Logo option on the View menu and 
navigated between the Group Settings and My Settings options.

 Resolved an issue in Web Verifier where the Group Selection list box erroneously 
appeared on the screen for a second while loading the Settings page. However, the list 
box did not display when the Settings page was loaded completely and the My Settings
option was enabled by default.

 Resolved an issue where the Cell Checked event was not triggered when the user opened 
a batch and selected or deselected a checkbox column in the table field.

 Resolved an issue where the Cell Focus Changed Event was not triggered when the user 
attempted to add or delete rows using Table Integrated buttons.

 Resolved an issue where the Cell Focus Changed event was not triggered when the user 
was opening the batch.

 Resolved an issue where the error message A relationship multiplicity constraint violation 
occurred. An EntityReference expected at least one related object, but the query returned no related 
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objects from the data store erroneously displayed when the user appended a document 
multiple times.

 Resolved an issue where the text was not wrapping into the next line and the user was 
erroneously allowed to type the characters continuously in a single line when the user 
typed multiline text in the Custom Script dialog box.

 Resolved an issue in Web Verifier where an incorrect Batch Close event was triggered 
when the user disabled the Hide batch release dialog option and selected the Close Batch 
and return to list option after validating a batch to completion state. The incorrect batch 
release action was also triggered when the user enabled the Hide batch release dialog
option and performed the above steps.

 Resolved an issue where Web Verifier failed to remove special characters and space while 
validating a field.

 Resolved an issue in Web Verifier where the pointer erroneously shifted to the end of a 
field when the user extracted data from a document into a field and attempted to 
manually correct the field data in Extraction Verification mode.

 Resolved an issue where the user made changes were saved when the user entered data 
inside a field, navigated to Document view or Tree view, selected No when prompted to 
save changes, and navigated back to Extraction Verification mode.

 Resolved an issue in Web Verifier where the Only is activated by the user option was 
erroneously selected in the Copy document to Knowledge Base area on the Supervised 
Learning tab.

 Resolved an issue in Web Verifier where the header fields erroneously remained in valid 
state without data extraction and the table fields remained in invalid state when the user 
reclassified a document in Extraction verification mode with the Perform automatic 
extraction after manual classification option disabled.

 Resolved an issue where the error message This windows user is unknown displayed when 
a nonexistent user logged in to Web Verifier for the first time and the error message did 
not display for subsequent login attempts. The errors for the subsequent login attempts 
were also not recorded in the Trace log file.

 Resolved an issue in Batch Verification view that occurred when a windows user logged 
in to Web Verifier from one computer for batch verification, logged in from a separate 
computer, and then attempted to continue with the batch verification process on the first 
computer. The error message Object reference not set to an instance of an object. displayed 
and the windows user was no longer able log in to Web Verifier from both computers.

 Resolved an issue where the correct table icon was missing when the user diminished the 
size of Web Verifier browser window.

 Resolved an issue in Web Verifier where the batch selection was not retained and the first 
batch was selected by default when the user navigated between Settings view and Batch 
view.

 Resolved an issue in Web Verifier where the layout of the error message Verification is 
possibly broken and the image in the Document view was distorted when the user 
attempted to open a batch using a project that is different from the one that processed the 
batch in Runtime Server.

 Resolved an issue in which an extra space appeared above the page icons in Document 
Tree view.

 Resolved an issue where the user was unable to open a document in Extraction view 
when other documents were out of workflow.

 Resolved an issue in Web Verifier where the OK button was missing in the Batch Filtering 
Conditions dialog box.

 Resolved an issue in Web Verifier where a batch due for extraction verification was 
opened when the user selected the Verify first invalid batch option and clicked the 
Verify batch icon even though the first invalid batch was due for document separation.

 Resolved an issue where the user pressed [Ctrl]+[T] key to select the Correct Table option 
and an error occurred in Web Verifier.

 Resolved an issue which caused a JavaScript error Unable to get value of the property ‘name’: 
object is null or undefined to display when the user deleted characters using [Backspace] 
key in a field which was auto filled.

 Resolved an issue where a stack trace error message was displayed and a blank screen 
appeared when the user attempted to log in with configured project settings and the 
project was removed later.

 Resolved an issue where the status bar displayed Batch: Null message instead of Batch: 
None message when no batches were available.
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 Resolved an issue that occurred when the user cut or appended using the shortcut keys 
[Ctrl]+[9] or [Ctrl]+[8], where Web Verifier displayed a JavaScript error Unable to get value 
of the property ‘Id’: object is null or undefined’ on using Cut shortcut.

 Resolved an issue where the toolbar became visible when the user unchecked the Toolbar
option from the View menu to hide the toolbar and switched to another mode 
(Verification mode).

 Resolved an issue where document and image menu shortcuts were not functional.
 Resolved an issue that caused the page to jump and center align the document on the 

page when the user double-clicked a batch or candidate.
 Resolved an issue in Web Verifier with exception handling settings where, when the user 

selected Settings > Exception Handling, selected any state, and right-clicked on the 
description, the description was right aligned instead of center-aligned.

 Resolved an issue in Web Verifier with exception handling settings where, when the user 
kept the mouse pointer on the New Description option, it showed Arrow cursor icon
instead of hand icon image.

 Resolved an issue in Web Verifier with exception handling settings where, when the user 
entered a long description in the New Description text box, the background color of the 
text box which was initially white turned red and when the user hovered the mouse 
pointer on the text box, an error message was displayed Description should contains 128 
character MAX.

 Resolved an issue in Web Verifier with exception handling settings. When the user clicked 
the OK button, the New Description text box was closed.

 Resolved an issue where the field space was less than expected between text and field 
border when the user double-clicked on a text item.

 Resolved an issue in which the current selection of the toolbar drop-down menu did not 
display the expected color.

 Resolved an issue where the junk page number appeared as it was in the text box when 
the user entered junk page number in the page navigation section and pressed [Enter] 
key.

 Resolved an issue that occurred in Web Verifier when the user opened the settings page, 
where all the settings in one page were displayed for a brief moment.

 Resolved an issue where the system did not display a warning message when the original 
order of documents was changed and the user sorted the documents in descending order 
while using the cut or append command.

 Resolved an issue where button sizes in the Batch Filtering Conditions dialog box were 
too small.

 Resolved an issue that occurred in Web Verifier when the user in Tree or Document view 
switched from the Three pages horizontally mode to Single page mode and selected any 
other document, where a blank screen was displayed in the document area.

 Resolved an issue due to which the Batch view displayed incorrect page numbering when 
no batches were listed because of applied batch filtering conditions.

 Resolved an issue where a read-only list box field erroneously looked like a text field.
 Resolved an issue in which the location of the Vendor Search dialog box shifted from the 

center of the page to the bottom left corner of the page when the user selected any entry in 
the vendor list.

 Resolved an issue where the warning icon did not display next to the warning message 
The job "XXX" is currently assigned to a verification batch root and is not configured for Learnset 
workflow. Would you like to continue? when the user selected a KB job identical to the 
verification batch root job.

 Resolved an issue where an extra space was noticed on the screen when the user hid a 
toolbar in the Extraction mode.

 Resolved an issue where there was no pointer placement to enter the class name in the 
Class Name text box when the user performed the cut command [Ctrl]+[X] on a 
multipage document under Classification mode.

 Resolved an issue where the shortcut key to open Web Verifier File menu was not 
working. The user can now open the Web Verifier File menu by pressing [Alt]+[L] key.

 Resolved an issue where the URL in Internet Explorer 11 browser was highlighted when 
the user pressed [Alt]+[D]. The user can now open the web verifier Document menu by 
pressing [Alt]+[U].

 Resolved an issue where the whole line of text was selected erroneously when the user 
attempted to select a single word in Document Viewer.
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 Resolved an issue where Windows Log off or Change Password screen opened when the 
user pressed the document navigation shortcut key [Ctrl]+[Alt]+[End] in Extraction view 
in Internet Explorer 11. The user can now go to the last document in the batch by pressing 
[Ctrl]+[Shift]+[End].

 Resolved an issue where View menu in Internet Explorer 11 opened when the user 
pressed [Alt]+[V]. The user can now open the Web Verifier View menu by pressing 
[Alt]+[W].

 Resolved an issue where Web Verifier did not prompt the user to save the changes when 
the user changed any settings and used [Ctrl]+[1] to switch to the Batch view.

 Resolved an issue where Web Verifier did not move the document right or left when the 
user zoomed in or out of the document and used [Ctrl]+[Right] and [Ctrl]+[Left] to shift 
the document.

 Resolved an issue where in Tree view, when selection was on document or page node and 
the user pressed [Ctrl]+[Up] and [Ctrl]+[Down], the focus changed to next or previous 
document or page, and it was highlighted in gray.

 Resolved an issue where selection in Document Tree mode was on page node and the 
user used page navigation shortcuts like [Ctrl]+[Home], [Ctrl]+[End], [Ctrl]+[Up] and 
[Ctrl]+[Down], the focus changed between batch and last page, and it was highlighted in 
gray.

 Resolved an issue where no action was performed when the user pressed [Alt]+[I] to open 
the Image menu in Batch view in Internet Explorer 11 and Chrome browsers. The user can 
now open the Web Verifier Images menu by pressing [Alt]+[M].

 Resolved an issue where no action was performed when the user pressed [Alt]+[O] to 
open Web Verifier Option menu in Batch view in Internet Explorer 11 and Chrome 
browsers. The user can now open the Web Verifier Option menu by pressing [Alt]+[N].

 Resolved an issue where no action was performed when the user pressed [Alt]+[H] to 
open Web Verifier Help menu in Batch view, Classification view, Extraction view, and 
Document view in Internet Explorer 11 and Chrome browsers. The user can now open the 
Web Verifier Help by pressing [Alt]+[P].

 Resolved an issue where the keys for navigating to the previous and next documents were 
not working properly. The user can now use [Page Up] for navigating to the next 
document and [Page Down] for navigating to the previous document in the Document 
view.

 Resolved an issue where the entire table row in Extraction view was not selected when 
the user selected the table row ID so that the mapped data was not highlighted in the 
document.

 Resolved an issue where the table data in the document retained the highlighting from the 
previous document in Web Verifier.

 Resolved an issue where the user ID was displayed as a question mark for an exception in 
the trace log file.

 Resolved an issue where a document rotated by 180 degrees instead of 90 degrees when 
the user rotated a document by 90 degrees, navigated to Tree view, and without saving 
the changes, attempted to rotate the document again.

 Resolved an issue where the user was allowed to select the unavailable option Verify this 
batch with next verification form in the Batch Completion dialog box.

 Resolved an issue where the Close button was not present in dialog boxes triggered by 
custom script.

 Resolved an issue where the width of the Description table column changed when the 
user navigated to the next table page.

 Resolved an issue where the Sort icon disappeared from the Batch view when the user 
sorted on any column other than priority, opened a batch, and returned to the batch list.

 Resolved an issue where the Documents table header was not properly aligned with the 
table column data when the user resized the Documents table column in Batch view.

 Resolved an issue in which the No Records Found message displayed improperly and 
overlapped with the OK button when the user searched for a record in the Vendor Search 
dialog box and no records were found.

 Resolved an issue where the column snap in controls did not display and the state icons 
were missing when the user moved a column from one location to another in Batch view.

 Resolved an issue where an extra space was found on the screen when the user hid the 
toolbar in the Classification view.
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 Resolved an issue where the user was unable to select the Close batch and return to the 
batch list option by clicking the text next to the option in the Batch Completion dialog 
box.

 Resolved an issue where the Route document script event was not triggered when the user 
reclassified the document.

 Resolved an issue where the separation bar between two documents did not display when 
the user selected Two pages horizontal view in the Tree view.

 Resolved an issue where an error was displayed Ext.MessageBox is null or not an object
where the user was redirected to Batch view when the user attempted to login as an auto-
imported user having no password.

 Resolved an issue where the Select Next Unsure Page option under the View menu was 
erroneously enabled after all the unsure pages were already accepted in the Tree view.

 Resolved an issue where the background color of the Apply button in the Batch Filtering 
Conditions dialog box and the OK button in the Exception Handling dialog box displayed 
in white instead of grey.

 Resolved an issue that occurred when user selection was on the last unsure page of the 
last document of the first page in Tree view. Previously, when the user selected the Select 
Next Unsure Page option under the View menu, the last document on the first page was 
erroneously selected instead of the first unsure page of the next document in the list.

 Resolved an issue where the user was unable to add a document to the learnset and an 
error message, Verifier is unable to connect to the batch root of global LearnSet displayed when 
the user launched Web Verifier and re-logged in as an admin user while the server was 
configured with Windows authentication.

 Resolved an issue where no visual feedback was received when the user clicked the 
Refresh button in the Web Verifier batch list view.

 Resolved an issue where no action was performed when the user entered Write Batch 
Filter condition in the text box and pressed Enter.

 Resolved an issue that occurred when the user, in Settings, selected a project and job and 
pressed Enter, where Web Verifier automatically redirected the user to the Save button.

 Resolved an issue where no action was performed when focus was on batch due for 
extraction verification and the user pressed [Enter].

 Resolved an issue where the user was unable to navigate between documents or pages in 
the Tree view using the [Up Arrow] and [Down Arrow] keys.

 Resolved an issue where the user was unable to shift focus between different controls of 
the script dialogs, for example in a Vendor Search dialog, by pressing the Tab key.

 Resolved an issue where when the user launched Web Verifier, navigated to Settings, and 
viewed the Output State the alignment of the Output State label was right instead of left 
justify.

 Resolved an issue in Web Verifier where the user was erroneously allowed to validate a 
hidden table column and the error message No Table Found displayed in the status bar. 
However, the user was unable to validate the document or batch completely and the 
expected error message did not display.

 Resolved an issue where the columns were not highlighted when the user selected the 
Switch Table Highlighting option on the menu in order to switch from learned lines or 
cell highlighting mode to the column-highlighting mode.

 Resolved an issue where a new exception batch was created and released immediately 
when the user moved a document to exception after selecting the Create new batches 
with documents marked for exception handling and Automatic release all available 
pending exception batches that contains 0 (Zero) or more documents options.

 Resolved an issue in Web Verifier where all the page navigation icons were erroneously 
enabled by default when the user opened a batch with the first document containing a 
single page in the Document Tree view.

 Resolved an issue that occurred when the administrator changed the language for the 
Verifier under group settings and saved the settings, where the language of the entire 
application for the administrator changed.

 Resolved an issue where all the SQL parameters were not logged in case of failure and the 
only SQL exception seen was System.Data.SqlClient.SqlException: Invalid column name 
'WrongSQL.

 Resolved an issue where the focus shifted to an invalid field when the user verified table 
field by extracting data using Correct Table option, kept focus on the Table field, and used 
the Switch Table Highlighting option.
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 Resolved an issue where table cells with only special characters could not be validated 
when the user entered only special characters and pressed Enter to validate.

 Resolved an issue where the special character ‘&’ disappeared from the table cell and 
could not be validated when the user entered ‘&’ once or twice in Table field and pressed 
[Enter] to validate.

 Resolved an issue where the pointer did not move from one list box type field to another 
and remained on the same field when the user pressed [Tab] key.

 Resolved an issue where OK button was always enabled in the Add State or Change State 
dialog boxes and the user was allowed to press OK button without any inputs.

 Resolved an issue where toolbar buttons for page navigation in Tree view were 
erroneously disabled, while the same options available under the Image menu were 
enabled and working as expected.

 Resolved an issue where the tooltip was not displayed for any of the integrated table 
buttons.

 Resolved an issue where the pointer was not visible and the table column was not 
automatically resized to provide the user with best fit of multiline text typed into the table 
cell.

 Resolved an issue where the same naming conventions were used for the context menu 
options Align & Copy to Current Field and Copy to Current Field for both table cell data 
and text box.

 Resolved an issue where a new line was added at the bottom when the user placed the 
pointer at the end of the second line in the table cell and pressed [Ctrl]+[Enter]. Similar 
issue was resolved when the current line was not broken down when the user placed the 
pointer in the middle of second line and pressed [Ctrl]+[Enter].

 Resolved an issue where the pointer position remained in the current line even though the 
user pressed [Ctrl]+[Enter] to insert a new line and would expect the pointer to be placed 
into the newly added line.

 Resolved an issue where a new line was not added when the user pressed [Ctrl]+[Enter]
and the data typed by the user into the snippet viewer new line was not reflected in the 
new line.

 Resolved an issue that caused the JavaScript error eventHandler is undefined to display for 
specific documents when the user extracted data into the table column and navigated to 
the last table page.

 Resolved an issue where the user was not able to view the check boxes for tables with 
check box column type in Extraction view using Internet Explorer browser.

 Resolved an issue where table cell data was not cleared when the user selected the option 
Unlearn line from the document area.

 Resolved an issue where double-clicking on a candidate found by auto-completion did 
not populate the candidate text into the field.

 Resolved an issue in which the application name displayed as Web Verifier Client instead 
of Web Verifier.

 Resolved an issue where the error message WDC form control Column with index 4 not found
was replaced with a more meaningful error message in Web Verifier when a new table 
column was added in Designer.

 Resolved an issue in Web Verifier where the CellFocusChanged event was not triggered 
when the focusChanged option was either enabled or not present in the config file. The 
Cell Focus Changed Event is not triggered now when the web.config parameters are set to 
false.

 Resolved an issue in Web Verifier where the CellFocusChanged events were erroneously 
triggered when the focusChanged option was disabled in the config file.

 Resolved an issue that occurred when the user opened any batch for extraction, selected 
Options > Reclassify the document manually, and entered a non-existing class to classify 
the document, no tooltip message was displayed.

 Resolved an issue when the JavaScript error this.candidateCtxMenu is null or not an object
displayed when the user selected the Append Field Text By Word option in the 
Document area.

 Resolved an issue where in the LoggedInUser table, LastActivityDate was stored using 
the local server time instead of UTC time.

 Resolved an issue in Web Verifier where the application name partially displayed in the 
dialog box title and the location of the Close button was incorrect.

 Resolved an issue in Web Verifier where the Save changes dialog box did not display 
when the user modified a document and moved the document to exception state.
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 Resolved an issue in Web Verifier where the table columns for a document were not 
highlighted properly when the user clicked the table header after switching between 
different modes and returning to the identical batch after mapping data into table 
columns in Extraction verification mode.

 Resolved an issue where check box type fields were erroneously deselected by default 
and the width of the text box type fields unexpectedly appeared too bright, thus covering 
other controls.

 Resolved an issue that occurred in Web Verifier when on a valid table that used multiple 
pages, one cell could be made invalid by emptying it and pressing Enter, where after that 
when the user pressed next table page button, the red triangle displayed for that same cell 
on a different page even if the cell was valid.

 Resolved an issue in which the validated table column data in the Document area was 
erroneously highlighted in red instead of green.

 Resolved an issue that caused an extra box to display around the toolbar in document 
area when the user clicked any of the toolbar icons in the Tree view.

 Resolved an issue that occurred when the user cleared field data using [Ctrl]+[X] in the 
field viewer, where the field preview control did not refresh.

 Resolved an issue in which an extra space was noticed within candidate text when the 
user extracted candidate using the context menu option Copy to Current Field.

 Resolved an issue in Web Verifier where an error message displayed when the user 
opened a batch in Tree view and attempted to append the pages of the previous 
document by selecting the Append this document to previous one option.

 Resolved an issue in Web Verifier for a two-page document in the Document Tree view 
where the selected page did not appear at the right side of the document viewer when the 
user selected the Two Pages Horizontally option.

 Resolved an issue in Web Verifier for a two-page document in the Document Tree view 
where the selected page did not appear at the bottom of the document viewer when the 
user selected the Two Pages Vertically option.

 Resolved an issue in Web Verifier for a two-page document in the Document Tree view 
where the selected page and the next page incorrectly displayed identical background 
colors.

 Resolved an issue in which the first letters of all the words did not display in uppercase in 
the Classification Verification and Extraction Verification options on the Settings menu 
and the Increase Image Area and Decrease Image Area options on the Image menu.

 Resolved an issue where the Up Arrow next to the ID column header for document IDs in 
Tree view and batch IDs in Batch view did not change to Down Arrow, as expected, when 
the user arranged the list items in descending order.

 Resolved an issue where the Correct Table and Last Document tooltips partially displayed 
in Web Verifier and erroneously merged with the page layout.

 Resolved an issue that occurred when the user selected batch, with multiple documents 
and clicked Show Selected batch, and clicked the Two Pages Horizontally view, the document 
page displayed on the right side in Zoom in view instead of Fit to Window view.

 Resolved an issue where the alignment of the table cell validity state icon (red triangle 
icon that is displayed for invalid table cells) on the top-right corner of some table columns 
changed when the user copied data into the table columns using the Copy to Current 
field option.

 Resolved an issue in which a new row erroneously appeared and the sorting icon 
displayed on top of the column name instead of the same line as column header text when 
the user resized any column in the batch list.

 Resolved an issue in which the auto-completion feature was not working for a field with 
activated char filtering validation settings.

 Resolved an issue where the error message Object reference not set to an instance of an object
displayed in the Append dialog box when the user right-clicked a document in Tree view, 
selected the Append this document to previous one option, and then clicked OK.

 Resolved an issue where the default table names erroneously displayed in Web Verifier 
table fields instead of the display names set by script in Verifier form load.

 Resolved an issue in the Tree view where the last unsure page displayed instead of the 
last sure page when the user clicked the Accept/Reject Next Unsure page option on the 
View menu and then clicked NO in the Batch Release dialog box. However, the last sure 
page displayed when the user refreshed the page.
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 Resolved an issue in Web Verifier where the validated field candidate was erroneously 
highlighted in yellow instead of green when the user extracted the candidate to a field 
and validated it.

 Resolved an issue where one table row erroneously spanned across three rows when the 
user selected any row of a table for which extraction verification has been completed.

 Resolved an issue where the candidates in Document view were highlighted in 
nontransparent yellow, making the text below the candidate unreadable, when the user 
selected a row of Table field that was extracted with field data using Runtime Server for 
the second time.

 Resolved an issue where highlighting of candidates remained and did not disappear from 
the document even when the user selected other extracted row in the table field.

 Resolved an issue where the candidates in the document view were highlighted with 
yellow color when the user selected a valid field (displayed in green color) or an invalid 
field (displayed in red color) in the verification form of Web Verifier.

 Resolved an issue where some table cells erroneously displayed the invalid red triangle 
icon while the table displayed in green when the user appended a row.

 Resolved an issue where the user preferences under Settings were not saved when the 
user opened a batch due for Extraction verification, went to the Option menu and selected 
the Set Exception Mode to Batch check box, returned to the Batch list and then Settings, 
opened the same batch, went to the Option menu and checked the selection.

 Resolved an issue that occurred when the user made changes in the document settings 
and pressed the Close button on the toolbar to move the entire batch to exception, where 
the user was not prompted to save changes.

 Resolved an issue where an error message Manual correction has been applied. You are about 
to invoke a learning operation, which is going to discard the manually applied changes. Would you 
like to skip learning? was displayed when the user pressed [Ctrl]+[T] to correct a table.

 Resolved an issue where the OK button was enabled on the New Description dialog box 
when the user did not enter any text in the text field and the OK button was disabled 
when the user clicked inside the text field.

 Resolved an issue where the user was unable to log in to Web Verifier when polish 
characters were entered for the User name and Password fields.

 Resolved an issue that occurred when the user navigated between documents in 
extraction mode, entered a document number manually and pressed Enter, where the 
Save Changes dialog box displayed the message Current opened document has been modified. 
Would you like to save current document?

 Resolved an issue that occurred when stack page error messages displayed in Web 
Verifier instead of user-friendly error messages.

 Resolved an issue where the list box value appeared twice when the user manually typed 
the value present in the list box, focus was kept on the field, and the user pressed Enter.

 Resolved an issue that caused an error message Object reference not set to an instance of an 
object. to appear when the user selected a value from the list box, validated, deleted the 
value from the field, and pressed Enter.

 Resolved an issue in Web Verifier where the user could not validate a List Box field with 
Allow list value only property as unchecked by typing text manually. The pointer 
incorrectly remained on the same field and the Please confirm. The automatic extraction was 
not sure. error message displayed.

 Resolved an issue where loss of data was reported when the user extracted table field data 
that had two pages of data and pressed [Shift]+[Tab] from second page and validated 
table field.

 Resolved an issue where the width of the table columns changed when the user navigated 
between table pages.

 Resolved an issue that occurred when the user selected the Correct Table submenu option 
in the Options menu, where the Options menu remained open.

 Resolved an issue in which the error message Invalid index for table row displayed when 
the user selected the Correct Table option on the Options menu after performing the 
Learn as Primary line operation for some lines and Learn as Wrong Line operation for 
the rest of the lines. The error message is no longer displayed.

 Resolved an issue where the error message Invalid Index for table page displayed when the 
user performed the Learn table lines operation.

 Resolved an issue in Web Verifier where the field erroneously remained valid when a 
script error occurred for the field.
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 Resolved an issue where the Simplified Chinese user interface translation for the OK 
button was incorrect in the Vendor Search dialog box.

 Resolved an issue where Web Verifier froze when the user pressed the [Esc] key in the 
dialog All batches which are not filtered, currently not locked and correspond to designed 
workflow have been verified.

 Resolved an issue where the user was erroneously able to type data in the table cells and 
shift focus from one table cell to another table cell by pressing the [Tab] key when the 
Vendor Search dialog box was open.

 Resolved an issue where the user was unable to perform any actions for a few minutes 
after attempting to close the Vendor Search dialog box by pressing [Esc].

 Resolved an issue where the web page became unresponsive when the user pressed the 
[Esc] key in a frozen Search dialog box.

 Resolved an issue where the error message Object reference not set to an instance of an object
displayed and the batch was not successfully appended when the user performed the cut 
or append command on batches pending extraction verification in Web Verifier.

 Resolved an issue where a field sometimes did not display red (invalid) color when the 
user deleted content of the previous field and confirmed the entry.

 Resolved an issue in Web Verifier where the size of the JPEG images transferred to the 
browser from the database appeared bigger than the actual image size as extra zeros were 
erroneously added to the actual image size. This issue occurred only for images retrieved 
from the database and not for images newly created on demand.

 Resolved an issue where the error message Invalid character found in the text displayed 
when the user attempted to validate a field in Web Verifier by extracting multiple lines 
using area selection.

 Resolved an issue where the user could not select a candidate using [Shift]+[Home].
 Resolved an issue where a cross mark (X) was displayed at the end of the field while 

validating the field manually.
 Resolved an issue where the user could validate a table field with a hidden invalid 

column without receiving an error message.
 Resolved an issue where the Document_FocusChange event was called but the new field 

index value set in the script was not applied when the user opened a batch in Web 
Verifier and the focus incorrectly shifted to the first invalid field. However, the new field 
index value was applied when the user moved to the next document.

 Resolved an issue in Web Verifier where a document that was imported using the 
Conversion to display format option in Runtime Server did not display properly when 
the user rotated the document. The orientation of the document changed to landscape 
mode but the document text did not rotate accordingly.

 Resolved an issue in Web Verifier where a multipage document erroneously remained in 
invalid state when the user accepted an unsure page in Document Separation mode.

 Resolved an issue in Web Verifier where documents were not automatically classified and 
extracted when the user selected the Always automatically re-extract data for poorly 
processed documents check box on the Supervised Learning tab, however, the user was 
able to successfully invoke the extraction process manually.

 Resolved an issue where JavaScript or object reference errors displayed when the user 
selected an option from the drop-down list in Extraction Verification view, and then 
attempted to modify or delete data.

 Resolved an issue in Web Verifier where the error message Verification is possibly broken 
because the project definition for the document was changed. Please reclassify the document again 
to reflect changes displayed when the user saved a non-validated reclassified document 
and attempted to reopen the batch.

 Resolved a memory leak issue in the IIS worker process with the Runtime Server display 
format enabled, where the memory used by JPEG images was not released when the user 
closed a batch or logged out of Web Verifier.

 Resolved an issue where the error message WVC is not subscribed... displayed when 
multiple users simultaneously opened a batch and clicked the Search button.

 Resolved an issue where the user was erroneously able to press Enter multiple times in 
the document class name combo box in Classification view, while re-classifying a 
document or clicking on Verify Batch toolbar button multiple times, leading to web 
server instability issues in some cases.

 Resolved an issue where Web Verifier erroneously skipped verification of table fields 
after validation of text fields, and the document verification process was considered 
complete with unverified table fields. After validation of the last text field in a document, 
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the application either moved to the next document in the batch or prompted to release the 
batch if this was the last document in the batch.

 Resolved an issue in Web Verifier where an incorrect vendor pool was used during 
extraction following manual reclassification to a class where the ASSA field was included 
as a classification field.

 Resolved an issue in Web Verifier in which the expected error message did not display 
when a table in the document contained any invisible but invalid table columns.

 Resolved an issue where the table cells were erroneously visible in Web Verifier when the 
user changed the state of all the table cells to invisible in Designer after processing a 
document through Runtime Server.

Engines  Resolved an issue where the Kadmos 5 engine returned an Invalid classifier name error 
when extracting a zone without changing the initial settings on the Recognition tab.

 Resolved an issue that occurred when grayscale 16-color 4-bpp TIF files were OCR’ed 
using FineReader 10 or 11.

 Resolved an issue where the Transcript engine delivered as part of 5649a patch provided 
less and worse extraction results for high school tables than in the previous version.

 Resolved an issue where the generic table extraction resulted in inconsistent identification 
of mapped columns for specific documents.

 Resolved an issue where the generic table extraction unexpectedly extracted label lines
among the correct line items.

 Resolved an issue where the generic table extraction did not extract data into the 
Description column.

 An issue where Runtime Server restarted repeatedly during Kadmos 5 zone extraction is 
resolved in Kadmos 5.0p.

 An issue where Runtime Server stopped responding during Kadmos 5 zone extraction is 
resolved in Kadmos 5.0p.

 An issue where Page Designer displayed an error message instead of the OCRed text is 
resolved in Kadmos 5.0p. The same error occurred in Runtime Server.

 An issue where the error message Redirecting document 00000xxx.wdc to failed state, due to 
timeout or crash in last two processing attempts. displayed in Runtime Server is resolved in 
Kadmos 5.0p.

 An issue where the error message Error 2 -2147483648 in Kadmos module RELLIB 
rel_graph_sort; Kadmos errormessage:loop; Kadmos systext: ||| displayed in Designer and 
Runtime Server is resolved in Kadmos 5.0p.

 An issue where the error message Error 2 -2013265920 in Kadmos module REL rel_do; 
Kadmos errormessage:Invalid parameter (rel->image.data==NULL); Kadmos systext: |||
displayed in Designer and Runtime Server is resolved in Kadmos 5.0p.

 An issue where the error message Error 2 -2147483648 in Kadmos module RELLIB 
rel_rec_graph; Kadmos errormessage:g_nr==18>rel->rel_graph_len==0; Kadmos systext:
displayed in Designer and Runtime Server is resolved in Kadmos 5.0p.

 An issue where the error message Table_Table" not in Collection. [Error] |30| 04:05:55.005 | 
612 | 12963660k/255445256k | 16633516k/255969704k | 226496k/168020k | 516 | 101/53 | 
Performing automatic restart after OCR failure. The processed document will be kept in its current 
batch state. One more processing attempt will be applied to try to recover the OCR engine.
displayed in Designer and Runtime Server is resolved in Kadmos 5.0p.

 An issue where Runtime Server stopped responding after subsequent documents caused 
a Classification and Extraction crash during Kadmos5 Zone OCR is resolved in Kadmos 
5.0p.

 Resolved an issue where the Kadmos 5 position options no touching char and no 
ligatures were not enabled by default and where changes made to these options were not 
saved.

 Resolved an issue that caused incorrect extraction during classification redirection to a 
parent class, if the user selected the Redirect after completion of extraction option.

 Resolved an issue that occurred when using Brainware Field Extraction to classify and 
extract a document, where Runtime Server and Designer stopped working if the 
document contained more than 200 lines.

 Resolved an issue where FineReader 11 stopped working during extraction.
 Resolved an issue where Runtime Server and Designer stopped working when using 

Kadmos 5 OCR zones in a project class.
 Resolved an issue where Designer or Runtime Server occasionally stopped working when 

applying document extraction using the Brainware Field Extraction engine.
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Designer  Resolved an issue where, under certain circumstances, an automation error displayed 
when the user tried to learn a document.

 Resolved an issue where text was pasted twice when pasted into a field with validation 
type List.

 Resolved an issue where learning an anchor using the anchor type Fit to box corner did 
not succeed.

 Resolved an issue that occurred when changing the classification settings without full 
relearning could result in incorrect classification. Now, when changing such a setting, 
classification is deactivated until full relearning is complete.

 Resolved an issue that occurred when using the Advanced Line
 Extraction method, where the Brainware Table Extraction engine was unable to learn lines 

of a document.
 Resolved an issue in Normal Train Mode, which prevented a field candidate to be 

populated after having activated table control.
 Resolved an issue in Designer where performing Analyze made the properties of the first 

field to be shown, irrespective of the currently selected field.
 Resolved an issue in Designer, where the ScriptModule object group was not visible in the 

script window after creating a new project.
 Resolved an issue that occurred when performing the OCR + Execute command on a 

document in Fields Mode, where OCR data could be erased from the workdoc.
 Resolved an issue that caused anchors to disappear when the user tried to create, move or 

resize the anchor.
 Resolved an issue where an incorrectly used variable prevented Designer from adding a 

document to the learnset in Verifier Train Mode.
 Resolved an issue in Designer where renaming a field in a class without a default 

verification form caused an error message.
 Resolved an issue where a zone disappeared when an anchor was added to the zone 

followed by performing of Read Zone recognition test from within the Properties of the 
zone on the Test tab.

 Resolved an issue that occurred when the anchor and zone objects were created using a 
JPEG document, where after closing and reopening Designer the anchors and zones 
disappeared.

 Resolved an issue in Designer for table validation, where selecting the validation type 
Amount or Date with no template returned a not meaningful error.

 Resolved an issue where Designer, in a Windows Server 2012 environment, did not 
respond when the option Always Valid on the Validation tab of the field definition 
settings was enabled.

 Resolved an issue where table highlighting was sometimes missing in Normal Train 
mode, not allowing the user to train the table.

 Resolved an issue that occurred when adding a document from the Classification learnset 
to the Extraction learnset, where another unrelated document in the learnset may have 
been lost.

 Resolved an issue where the user was not prompted to save the changes when closing the 
program in case new zones or anchors were added to the project.

 Resolved an issue that occurred when attempting to perform OCR on a CJK document, 
using a project that is configured to OCR Chinese, Japanese, Korean, or Thai, where in 
Runtime Server and Designer the error Analyzed Page found was returned.

Designer and Verifier  Resolved an issue where when using the Brainware Table Extraction engine and the 
Correct Tables feature it was sometimes no longer possible to learn additional lines and a 
learned line was unlearned. In order to continue with the table training, the user had to 
deactivate and then reactivate the Correct Tables feature.

 Resolved an issue in Verifier Train Mode in Designer and Verifier where the program 
removed one extra row from the table if the row was a merging result of two rows 
containing only empty cells.

 Resolved an issue that caused Designer and Verifier to stop working when using the 
Append Cell Text By Word/Replace Cell Text By Word option.

Designer and Runtime 
Server

Resolved an issue where the error message Finereader 10' at page 1: Not able to create image in 
memory occurred when LZW compressed TIF files were OCR’ed.
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Database  Under certain circumstances, the exception The batch with ID: <BatchID> could not be loaded 
because it is currently locked for Import. was logged many times in the SQL Server logs. This 
entry was logged erroneously and does not appear any more now.

 Resolved an issue where new documents were imported into an existing batch when the 
Runtime Server Import instance restarted during processing and the Activate High 
Priority Mode was Enabled.

 The installation no longer creates the admin account when creating the database for new
installations.

 Resolved an issue where browsing the local file system was not possible when working 
on a non-English OS.

Scripting  Resolved an issue where, when a table cell was set to Invalid in the Document_Validate
event, an error message erroneously indicated that the table is invisible and invalid. This 
error message does not appear any more now.

 Resolved an issue where it was not possible to change the pWorkdoc.DisplayPage value in 
the class script events Document_OnAction, Document_Validate, Field_Validate and 
Table_CellFocusChanged.

 Resolved an issue where, when a table cell was set to Invalid in the Document_Validate
event, an error message erroneously indicated that the table is invisible and invalid. This 
error message does not appear nowa.

 Implemented page navigation in Verifier by setting the pWorkdoc.DisplayPage value in the 
class script events Document_OnAction, Document_Validate, Field_Validate, and 
Table_CellFocusChanged. 

Note: In Oracle WebCenter Forms Recognition 11.1.1.9.0 and earlier, such navigation 
was possible though not all controls were properly refreshed. Also, this 

functionality is not available for Web Verifier.

Learn Set Manager Resolved an issue where the line items remained highlighted in grey when the Correct table 
button was disabled in the Accumulated Documents Browsing mode.

Document Filters  Resolved an issue where an Out of memory error occurred in Runtime Server during OCR 
of a 196-pages PDF.

 Resolved an issue in Web Verifier where the function Append document to previous one 
performed on PDF or Excel files resulted in the error message Append operation for 
documents containing reference to no-image file is impossible.

 Resolved an issue where tabs and spaces from a text file were incorrectly maintained 
when imported in Designer.

 Resolved an issue where Runtime Server stopped responding during OCR of a large text 
file.

 Resolved an issue where numbers and dates in an Excel file where not OCR’ed during 
import in RTS.

 Resolved an issue where the structure of a table in an email was not correctly imported.
 Resolved an issue where several words did incorrectly not highlight and OCR’ed text was 

wrongly appended to other words.
 Resolved an issue where the rendered image of a TXT file extended beyond the bottom of 

the page.
 Resolved an issue where Runtime Server stopped responding when importing a 

corrupted PDF file instead of moving the file to the bad images directory.
 Resolved an issue where bold formatting was removed during the import using Runtime 

Server.

Workdoc Browser  Resolved an issue where an error message appeared when the user exited the Workdoc 
Browser for the first time after the installation.

 Resolved an issue in Workdoc Browser when the user entered invalid login credentials, 
where a misleading error message was returned.

 Resolved an issue that occurred in Workdoc Browser when the related config file is not 
correctly configured, where a meaningful error message is now displayed and working in 
the file system mode is allowed.
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 Resolved an issue where the table attribute of the Workdoc Browser did not display any 
properties.

 Resolved an issue where the Workdoc Browser was not able to open files using UNC 
paths to access shared files on the network.


